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Introduccion

A lo largo de esta memoria, vamos a realizar una serie de ejercicios propuestos con distintos
entornos de desarrollo de aplicaciones para la adquisicién de datos. Los programas que vamos
a utilizar seran XLinx, HPVEE en su versién 5, TestPoint y LabView, ambos en su versidon 6.

Dado que los comandos enviados a la unidad se repiten en todos los entornos, hemos escrito
un anexo donde se muestran todas sus descripciones.

Todos estos ejercicios se han realizado durante las clases practicas de la asignatura Ampliacién
de Fisica, impartida por el Dpto. de Fisica Aplicada 1 de la Universidad de Sevilla.
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Material necesario

Para poder cumplimentar las practicas descritas serd necesario satisfacer los siguientes
requisitos:

Materiales
e K2700.
e Tarjeta de adquisicién de datos K7700.
e Fotorresistencia (LDR).

e PTC.
e NTC.
e PT100.

e Termopar tipo T 6 K.

Software
e Keithley 2700 XLinx.
e HPVEES5.0

e TestPoint 6.0.
e National Instruments LabView 6i.

Rafael Vargas Sanchez.
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Practica 1: Xlinx

Introduccion
En esta practica daremos los pasos para la correcta configuracion del programa Xlinx.

Xlinx es un programa disefiado para mostrar de forma rapida y facil graficas de los datos
tomados por el K2700, tras unas sencillas configuraciones y sin necesidad de programar.

Objetivos
En esta practica configuraremos el Xlinx para leer los sensores conectados a los canales del
K2700. En el Anexo A se especifican que sensores utilizaremos y cémo se han de conectar.

También mostraremos la forma de crear graficas de un dispositivo o de varios dispositivos
(simultdneamente).

Por ultimo guardaremos los datos mostrados en las graficas en distintos tipos de archivos
(texto plano u hoja de calculo en formato Microsoft Excel).

Rafael Vargas Sanchez.
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Practica

Configuracion de los canales
En este apartado explicaremos como configurar el XLinx para leer datos de los distintos
sensores utilizados.

Para ello configuraremos el tipo de sensor conectado a cada canal del K2700 (llustracién 1).

Senzor
Tope: |T_I,l|:ue T Therm-:u:u:-upj

. | Type T Themocoupl ]
LI Type E Thermocauph

Type B Thermocoupl
Type 5 Themocouph
Type M Thermocoupl
PT100 4 ez RTD
D100 4 wires RTD
F100 4 wirez RTD
PT391E6 4 \Wires RTL ™

o Gguie ey

llustracion 1: Tipo de sensores disponibles
en el XLinx

Canal 101 LDR
La LDR es un sensor que manifiesta la alteracion de la magnitud fisica (intensidad de la luz),
variando su resistencia.

El K2700 no dispone de la funcién de equivalencia de Ohmios (Q) a Lux. Por lo tanto,
configuraremos este canal para mostrar el valor de la resistencia.

El tipo de sensor serd pues un aparato de medida de resistencia con 2 vias.

Canal 102 PTC
La PTC aumenta su resistencia al sufrir un aumento de temperatura.

El K2700 tampoco dispone de la funcidn de equivalencia en este caso, pero la funcion del
termopar tipo K aproxima bastante el valor.

Por lo tanto configuraremos este canal como un termopar de tipo K.

Canal 103 NTC
La NTC también reacciona a los aumentos de temperatura con un cambio de resistencia, en
este caso con una disminucién de la misma.

En este caso el K2700 si dispone de la funcion de equivalencia.
La configuracidn que se le debe de aplicar es la de termistor de tipo 1950.

Canal 104 TC
El termopar traduce aumentos de temperatura en voltaje.

Rafael Vargas Sanchez.
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El K2700 dispone de la funcién de equivalencia de todos los tipos de termopares. Sin embargo,
para una medicién correcta debemos ajustar el sensor para que utilice el termdmetro interno
del aparato (llustracion 2).

Senzor

Type: |Ty|:ue T Thermncuupj

CIC: | Simulated j
External

Sirmulated

llustracion 2: distintos tipos de union fria
(cold junction)

Entonces la configuracidn del canal sera termopar tipo T y la CJC serd interna (llustracion 3).

Keithley Model 2700 : TEMP Function Setup

Channel
Tag Mame : |TE

Location : |[@'| 04]

Speed and Resalution Filter

Pricrity : | Speed [Mplc) ﬂ Type: | Dizabled j
| = |

Mple : |1 |

Senzor

Type: |T_I,I|:ue T Thermncnupﬂ Unit : |Eelsius ﬂ

CIC: | Sirnulated j Reference [Deq C] : |23
External |
Simulated Ii

[v Apply Changes Immediately to Device Help | Apply | Cloze |

llustracidn 3: configuracion del termopar tipo T

Canales 105 (y 115) PT 100
La PT100 es un sensor de temperatura por variaciones de resistencia, pero a diferencia de la
PTCy la NTC utiliza 4 vias para funcionar.

El K2700 dispone de la funcion de equivalencia y al configurarlo como una PT100 sabra
automaticamente que el dispositivo es de 4 vias.

La configuracidn de este canal es una PT100 de 4 vias (llustracién 4). No se requiere especificar
mas, pues por defecto se mide en grados Celsius.

Rafael Vargas Sanchez.
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Keithley Model 2700 : TEMP Function Setup

— Channel
Tag Marme : IF'T'IDD

Location : I[@1 0]

— Speed and R eszalution — Filter
Priarity : . [Mplc] Type: IDisaI:uIed LI
Resolutior : IE_E Digits LI Weight : I'I 0
Mplc 1 Wwindow:  J0.01
— Senzar
Type: |PT1004%ies RTD »|  Unit: | Celsius Ea

CIC: ISimuIated LI Reference [Deg C]: |23
Ilzer BTD Zero Fes I'I a0 Izer BT Alpha Coeff : IEI.EIEISEE
lzer BTE Beta Coeff ; IU.1'I1 zer BTD Delta Coeff : I'I.EEI?

¥ Apply Changes Immediately to Device Help | Apply I Cloze |

llustracidn 4: configuracion de la PT100
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Graficas y Exportacion de datos
El Xlinx es un programa para realizar una serie de medidas rapidamente y mostrarlas en una
grafica, gracias a su facil configuracion.

Single Channel View
Para mostrar una grafica, una vez configurado, basta con seialar el sensor que queremos
medir. Por ejemplo: la LDR y pulsar el botén Start (llustracidn 5 e llustracion 6).

Single Channel Yiew | |

Acquizition Control Panel

-
-
0,39073 KOhms - o

[ I I N | | |

Real-titne Data for Chamnel: LDR

So0a

Fooo

wOooo

2000

1000

93
ng Mumber

llustracion 5: ejemplo de medida de un solo canal

Rafael Vargas Sanchez.
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Single Charirel Wiew | |

Arquizsition Cantrol Panel

Type

0,37937 KOhms

Real-timme Data for Channel: LDR

Reading Mumber

llustracion 6: ejemplo de medida de un solo canal.

Existen tres modos de tomar datos en el Xlinx (llustracion 7):

e Single: Toma un numero exacto de medidas.
e Timed: Toma medidas durante el tiempo especificado.
e Continuous: Toma medidas hasta ser parado.

Rafael Vargas Sanchez.
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Acquizition Control Panel

Type Iij

" Single
" Timed

{* Confinuous Ii

Start ‘ ‘ Cfa Graph

llustracion 7: configuracion de la medida

Las graficas producidas se pueden configurar en el botén Cfg Graph. En la ventana que aparece
se puede modificar el nUmero de medidas que muestre, activar o desactivar la auto-escala del
eje y restringir los valores mostrados en la llustracién 8.

Configure Single Channel Yiew Gr... [Z|

Hafiz Settings

Total Paoinks Ons-axis (only 100

uzed for continuous mode]

Points In Wiess O s-deis 10

iz Settings
Auta Scale

™ True i+ Falsel

et

bl anwal v-axiz Parameters

Min " Y alue 110
Max % Walue 111

Ok Cancel

llustracion 8: configuracion de la grafica

Rafael Vargas Sanchez.
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Multi Channel View
El Xlinx también puede realizar graficas de dos sensores enfrentados e incluso mostrar las
graficas de 4 sensores a la vez (llustracién 9).

Si queremos mostrar graficas de mds de un dispositivo, sélo hay que pulsar la pestaifia Multi
Channel View.

Single Channel Wiew Fulti Chaninel Wiew
Channels to graph
Start Scan Scah Setup Scan List
RN RTE I B [ =
j | |Nme j Grogh Setip ngeDa[a

llustracién 9: multiples sensores simultaneamente

En la siguiente pantalla seleccionamos los canales que queremos medir.

Channels to araph

N T ~ | [Mone |
B o4 x| None [~

También podemos cambiar la configuracidn en el botdn Scan Setup

Rafael Vargas Sanchez.
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En la pantalla de configuracion (llustracion 10) podemos cambiar el numero de medidas, el
tiempo entre las medidas de los distintos dispositivos y cada cuanto se actualiza la grafica.

Multi Channel ¥iew Scan Setup [5_<|

Timing Parameters

Trigger Source

|mmediate

Delay Between Scanz [Secs]
Delay Between Channels [Secs) |1

Scanning Parameters
Murmber of Scans

Tatal Scans B0 ::||

[ Continuous Scanning
Graph/Data Update
f* |lpdate On Scanning Complete

" pdate "While Scanning

IIpdate Evemn Scanz

| 4|
Ok Cancel

llustracién 10: configuracion de Multi Channel View

Una vez realizadas las graficas los datos de estas pueden ser guardadas pulsando el boton Save
Data. Estos datos pueden ser guardados en texto plano o en una hoja de calculo Microsoft
Excel (*.xls).

Rafael Vargas Sanchez.
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Practica 2: HP VEE

indice
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Introduccion

En esta practica realizaremos medidas con el K2700 utilizando el programa HPVEE.

Para ello realizaremos una serie de programas de complejidad creciente capaces de realizar
medidas de todos los dispositivos, mostrarlas por pantalla, en una grafica y guardarlas en un
fichero con formato de tabla.

También realizaremos programas capaces de medir un nimero de medidas y programas
capaces de medir durante un tiempo determinado.

Objetivos

Realizaremos cinco programas de propésito especifico:

e Programa 1: leer de un solo dispositivo un nimero de medidas y mostrarlas por pantalla.
Fichero PO2Prog01.vee.

e Programa 2: leer de todos los dispositivos un nimero de medidas y mostrarlas por
pantalla. Fichero PO2Prog02.vee.

e Programa 3: leer de todos los dispositivos un nimero de medidas y las guardarlas en un
fichero con formato de tabla. Fichero PO2Prog03.vee.

e Programa 4: leer de todos los dispositivos un nimero de medidas y mostrarlas en una
grafica. Fichero PO2Prog05.vee.

Rafael Vargas Sanchez.
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e Programa 5: |leer de todos los dispositivos durante un tiempo y guardar las medidas en un
fichero con formato de tabla junto con el tiempo en el que fueron tomadas. Fichero
PO2Prog05.vee.

Practica

Programa 1: Medidas de un sensor

En este programa realizaremos diez medidas de la PT100 y las mostraremos por pantalla.
El primer paso es configurar la entrada y salida en el mend 1/0 > Instrument Manager

(Hustracién 11)

IJO s S eeies el

"N

Advanced IO »

Bus 10 Monitor

Fram g DataSet
To/From Named Pipe (LINIX) i

To/From Socket Pr|r.1ter
To/From DDE (PC) String

HP BASICUX (UMIX) L4 StdQut (LIMIX)
Execute Program (LUMIX) StdErr (LIMIX)

Execute Program (PC)
- -
Print Screen 3 -

llustracion 11

Dentro de esta ventana pulsamos Add Instrument (llustracion 12)

Rafael Vargas Sanchez.
Alfredo Michan Amado.
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Instrument Manager |
~Instrument List - Configuration
1 My configuration 21| Addinstrument.. |
=¥ HP4BO |
keithley2700(@(NOT LIVE)) Delete Instrument

-9 HPIB7 Edit Instrument... |

dmm(hp34401a@NOT LIVE)) Auto Configure |

dvmihp3478a@(MOT LIVE))

fgen(hp3328b@(MNOT LIVE)) -Create 'O Object——

funcgen(hp33120a@(MNOT LIVE)) Direct /0 |

oscope(hpS4G600@(NOT LIVE))

scope(hp54504a@(NOT LIVE)) PIiGEpIaYDrver |
-8 Serialg Fanel mhiver |

serial(@(MNOT LIVE)) r :
L vren j EOMponent Drrv'erl

SaveCnnﬁgl Cancel Print | Help |

llustraciéon 12
Configuramos los datos:

Device Configuration | Name: Keithley2700
Interface: GPIB

MNarme: M Address: 16
Interface: | HP-I1B vI
Address (eg 714): | 0

Gateway: This host |

Advanced IO Config .|

OK | Cancell Helpl

llustracién 13: configuracion

Una vez configurado regresamos al menu Instrument Manager y esta vez pulsamos Direct 1/0

Con esto crearemos un objeto para escribir instrucciones en el K2700 (llustracién 15y
llustraciéon 14).

Rafael Vargas Sanchez.
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= keithley2700 ( @ (NOT LIVE)) I

WRITE TEXT "RS5T" EOL

WRITE TEXT "FUNC YTEMPY EOL

WRITE TEXT "TEMP.TRAM FRTD" EOL
WRITE TEXT "TEMF:FRTD:TYPE FT100" EOL
WRITE TEXT "ROUT:CLOS (@105)" EOL

llustracion 14: 1/0 device
minimizado

llustracion 15: 1/0 Device con varias instrucciones

Haciendo doble clic en cada linea se abre una ventana en la que podemos elegir lectura o
escritura y en la que podemos escribir las instrucciones (llustracién 16).

11O Transaction

WRITE =] | TEXT =
[ DEFAULTFORMAT [~ EOLON |

ok | nop | cancel

llustracion 16: las instrucciones se deben escribir con el formato de los strings en C.

Escribimos las instrucciones necesarias para configurar el K2700 para leer datos de la PT100.
Estas instrucciones se encuentran en el Anexo B.

Ahora necesitamos un dispositivo que nos permita leer secuencialmente las diez medidas: un
objeto For Range. (llustracion 17)

—-|For|'1'_,ange| F
Fram |I:I

Thru IQ
Step |1

llustracién 17

Este objeto se encuentra en el menu Flow >Repeat.

Conectamos el canal derecho del objeto I/0O al canal superior del objeto For Range. Ahora
creamos otro objeto 1/0, le introducimos las instrucciones necesarias para leer un dato y
conectamos su canal superior con el canal derecho del For Range. Si cometemos algin error al

T

conectar estos dispositivos, hemos de utilizar el icono Delete Line gue se encuentra en la

barra de herramientas.

Rafael Vargas Sanchez.
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s . . - .
Otros elementos utiles en la barra de herramientas son: el icono Run , que ejecuta el
—4

programa; el icono Show Execution Flow ial

=]

, que nos permite seguir el orden de ejecucién de

los objetos; o el icono Show Data Flow
datos.

, que nos permite seguir el desplazamiento de los

Para poder mostrar los datos por pantalla necesitaremos un Logging Alphanumeric (llustracién
19y llustraciéon 20), objeto que se encuentra en el menu Display.

~|PT100¢°C)|

s AlphaNumeric |

1 llustracion 18:
AlphaNumeric
minimizado

llustracién 19

Creamos por lo tanto un Logging Alphanumeric que llamamos PT100 y conectamos su canal
izquierdo con el canal derecho del segundo objeto I/0.

El aspecto del programa terminado serd similar a la llustracion 21:

Rafael Vargas Sanchez.
Alfredo Michan Amado.

llustracién 20
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WRITE TEXT ™RST" EOL

WRITE TEXT "FUNC YTEMPY" EOL

WRITE TEXT "TEMF:TRAM FRTD" EOL
WRITE TEXT "TEMP:FRTD:TYPE PT100" EOL
WRITE TEXT "ROUT:CLOS (@105)" EOL

WRITE TEXT "READ?" EOL
READ TEXT y REAL

llustracién 21: Programa 1

Rafael Vargas Sanchez.
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Programa 2: Medidas de varios sensores

En este programa realizaremos diez medidas de todos los dispositivos y las mostraremos en
pantalla. Utilizando la configuraciéon de entrada/salida del programa anterior, creamos un
objeto I/0 y le introducimos la instruccién de reseteo.

A continuacion creamos un objeto For Range, y conectamos su canal superior con el canal
inferior del objeto 1/0.

Ahora necesitamos un objeto |/O para cada aparato, y en ellos colocaremos las instrucciones
necesarias para medir en cada sensor [Ver Anexo B]. También necesitamos un Logging
Alphanumeric para cada sensor.

Los objetos I/0O se uniran los unos a los otros utilizando los canales superior e inferior, uniendo
el superior al canal inferior del For Range. Los Logging Alphanumeric se unen por sus canales
izquierdos con los canales derechos de sus objetos I/O respectivos.

Después de realizar estas uniones, el programa quedara como la llustracion 22:

llustracién 22: conexion en cascada

Rafael Vargas Sanchez.
Alfredo Michan Amado.



Memoria de Ampliacién de Fisica| 2008

Programa 3: Fichero

Este programa lee diez medidas de todos los dispositivos y las guarda en un fichero con
formato de tabla. Para la lectura de medidas crearemos seis objetos 1/0, un objeto For Range y
cinco objetos Logging Alphanumeric. Estos objetos los conectamos en el mismo orden del
programa anterior e introducimos en los objetos I/O las mismas instrucciones que el programa
anterior.

Con esto conseguimos una estructura capaz de leer los datos del K2700.

Para poder escribir en un fichero, necesitaremos un objeto To File (llustracion 23), que se
encuentra en el ment 1/O > To.

To File 1=

ToFile: Cmedidas bd |

¥ Clear File At PreRun & Open

WRITE TEXT a EOL
WRITE TEXT b EOL
WRITE TEXT cEOL
WRITE TEXT d EQL
WRITE TEXT e EQOL
WRITE TEXT fEQOL
WRITE TEXT "rin”

S CIRE I N

llustracion 23: To File con varias entradas

Este objeto es similar al objeto 1/0 con el que enviamos instrucciones al K2700.En este caso
también podemos enviar lineas, que en este caso se guardaran en el fichero. Ademas podemos
seleccionar la ruta del mismo.

Unimos entonces el canal superior de un objeto To File en el que introducimos la cabecera del
fichero al canal inferior del objeto I/O que manda el reseteo al K2700.

Ahora creamos otro objeto To File y le creamos seis entradas (llustracion 24): una para cada
sensor y una mas para contar el nimero de medidas. Las conectamos con los canales derechos
de los objetos 1/0 y del For Range.

Rafael Vargas Sanchez.
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*=*=To File === I

Restare
Move
Size
Minirnize

Clone
Replace
Help

Properties
Description

Add Terminal k Data Input... Cirl+A

Delete Terminal k Control Input...

Add Trans... [ata Qutpuk, .,  ChEHa
Insert Trans... Cirl+0 Error Qutput

Cut Trans Cirl -+
Copy Trans

Paste Trans ChH ile
Print Trans

edidas. b

25 PreRun & Coen

llustracion 24

En ese objeto creamos las lineas para mandar los datos y un salto de linea en la dltima linea.

Después modificaremos las propiedades (Menu contextual > Properties) el caracter de salto de
linea, que lo modificaremos por “\t”.

Al terminar el programa quedard como la llustracion 25.

Rafael Vargas Sanchez.
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To File: Chmedidas |

¥ Clear File At PreRun & Open

WRITE TEXT a EOL
WRITE TEXT b EOL
WRITE TEXT cEOL
WRITE TEXT d EQL
WRITE TEXT & EOL
WRITE TEXT fECL

WRITE TEXT "rin”

ERERENENE

-

llustracién 25: programa 3 finalizado

Rafael Vargas Sanchez.
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Programa 4: Graficas

Este programa es similar al programa 2, pero en este caso los datos se representaran en
graficas en lugar de en Logging Alphanumeric. Por lo tanto, también crearemos 6 objetos I/O y
un For Range. Estos objetos serdn dispuestos y configurados de la misma manera que en dicho
programa.

Las graficas, objetos X vs Y Plot (llustracion 16), se encuentran en el menu Display.

~ PT100 (°C) Ir]
26.42

¥ name 26.42
26.41

26.41

264

264

YData1 26.35

26.39

-

1 26.38

X name

llustracion 26

Creamos cinco objetos X vs Y Plot (uno para cada sensor) y conectamos la entrada izquierda
superior de todas con la salida derecha del For Range y la salida izquierda inferior con la salida
derecha del respectivo objeto I/0.

Como curiosidad, en este programa afiadimos un ultimo objeto 1/O, con las instrucciones
necesarias para que el K2700 muestre en su pantalla el texto “Finalizado”. Este objeto serd
conectado en su canal superior al canal inferior del For Range.

El programa resultante serd igual a la llustracion 27:

Rafael Vargas Sanchez.
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|

PT100 (°C)

26.42

Y name 26.42
26.41
dithley2700 (@ (MOT LI 1
26.41
O 26.4
For Range 264

YData1 26.29

sithley2700 ( @ (NOT LI

26.39

26.38

o

...........

[k
sithley2700 ( @ (NOT LI

o
sithley2700 ( @ (NOT LI

sithley2700 ( @ (NOT LI

s
s
s

sithley2700 { @ (NOT |_|VJJ

dthley2700 (@ {Nlj'T LI

llustracién 27

Rafael Vargas Sanchez.
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Programa 5: Tiempo
Este programa realizara medidas de los dispositivos durante 1800 segundos (media hora) y
luego las guardara en un fichero de texto plano con formato de tabla.

Ya que es un programa dependiente del tiempo no nos servira el objeto For Range.
Necesitamos pues un objeto para medir el tiempo, el objeto Timer del menu Device(llustracion
28).

Timer

llustracion 28

También necesitaremos objetos de control de flujo para leer datos mientras se cumpla una
condicidn, en este caso que el nimero de segundos transcurridos A < 1800. Para controlar la
condicion utilizaremos un objeto If/Then/Else (llustracién 29) que se encuentra en el menu
Flow > Repeat. Si se cumple la condiciéon introducida la ejecucidn del programa sigue por el
camino Then vy si no sigue por el camino Else.

—| IfThenElse | -|

Iﬂ [wanu Then
Elze Else

llustracién 29

Para repetir las medidas utilizaremos objetos Until Break (llustracién 32), Next (llustracién 31)
y Break (llustracion 30), todos del menu Flow. Si el programa llega a un objeto Next regresara
al objeto Until Break y continuara por la derecha. Si el flujo nos lleva a un Break regresara al
objeto Until Break y continuara por abajo.

N

Lntil Breal N;xtl Er;ak
llustracion 31 llustracién 30

llustracién 32

Necesitaremos también un objeto Concatenator (llustracién 33), del menu Data, para
concatenar todos los datos en una linea, es decir, es un array de una dimension.

Rafael Vargas Sanchez.
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| Concatenator| 4 |

Array n

[+[n[e[o]a[>

llustracion 33

Por ultimo necesitaremos un objeto para guardar los datos antes de escribirlos en el fichero,
paso que se realiza al final de la ejecucién del programa. Este serd un objeto Collector
(llustracidn 34) del menu Data.

- Collector =l
10ata | o it Shape

n+1 0im ﬁ.rra].rl MI
1 XEQ |

llustracion 34

Ahora disefiaremos la parte del programa que realiza las medidas.

Creamos un objeto I/O para mandar una sefial de Reset al K2700. Unimos el canal inferior de
este objeto al canal superior del Until Break. Después creamos 5 objetos I/O, uno para cada
sensor, e introducimos en ellos las instrucciones necesarias para leer del sensor
correspondiente. Unimos los canales superiores e inferiores entre si, el canal superior del
primero con el canal derecho del Until Break y el canal inferior del dltimo con el canal superior
del If/Then/Else. En este bloque de objeto se realizaran las medidas.

Unimos ahora el canal izquierdo superior del Timer al inferior del objeto I/O que resetea, vy el
canal izquierdo inferior al canal derecho del Until Break. Con esto el Timer empezara a contar
después de resetear el K2700 y devolvera el tiempo transcurrido cada vez que empecemos una
serie de medidas.

Creamos en el Concatenator seis entradas y las conectamos con los canales derechos de los
objetos I/0 de los sensores y del Timer. Asi la salida del Concatenator serd una cadena con el
tiempo y todas las medidas, separadas con tabuladores.

Conectamos el canal derecho del Concatenator con el canal superior izquierdo del Collector,
que ira guardando todas las cadenas con las medidas y el tiempo hasta el final del programa.

Creamos un objeto To File. Conectamos el canal izquierdo del mismo con el canal derecho del
Collector, el canal superior con el canal inferior del Collector y el canal inferior con el Break. En
la primera linea del objeto To File escribimos la cabecera del archivo y en la segunda
escribimos el contenido del Collector. Este objeto, cuando se ejecute, escribird el archivo
entero en un solo paso (a diferencia del objeto To File del programa 3) y terminard la ejecucion
del programa.
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Por dltimo conectamos el canal derecho del Timer con el canal izquierdo del If/Then/Else, el
canal Then con el Next y el canal Else con el canal izquierdo inferior del Collector para cerrar el
bucle.

El aspecto final del programa sera igual al siguiente:

Rafael Vargas Sanchez.
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Practica 3: TestPoint 6.0

Introduccion

En esta practica aprenderemos a utilizar la herramienta TestPoint en su version 6.0. TestPoint
es una utilidad de creacién de programas orientados a la adquisicién de datos. TestPoint nos
ofrece una gran facilidad para desarrollar interfaces graficas de alta calidad y nos permite
controlar un gran nimero de dispositivos existentes en el mercado.

Objetivos

En esta practica desarrollaremos cinco programas en los que utilizaremos las caracteristicas
usadas con mayor frecuencia. Controlaremos el K2700 escribiendo directamente en el bus
GPIB las ordenes necesarias para leer las medidas de los sensores y presentaremos la
informacidn de forma adecuada por la pantalla, bien sea en un cuadro de texto, una tabla o
una gréfica. Por ultimo, aprenderemos a volcar la informacién obtenida a un fichero de texto
plano.

Los cinco programas que desarrollaremos son los siguientes:

® Programa 1. Lectura de un termopar tipo T en °C y presentacién en una gréfica de
esta. Fichero PO3Prog01.tst.

® Programa 2. Igual que el anterior pero midiendo el tiempo transcurrido de cada
medicion. Fichero PO3Prog02.tst.

® Programa 3. Igual que el anterior pero ademds afiadiendo a una tabla (Grid) los
valores obtenidos. Fichero PO3Prog03.tst.

® Programa 4. Volcado a fichero de la tabla anterior. Fichero PO3Prog04.tst.

® Programa 5. Lecturas de todos los dispositivos, almacenamiento en tabla de las
mediciones, medida del tiempo transcurrido, presentacién grafica de tres de ellos y,
por ultimo, volcado a fichero de la tabla con formato y valores redondeados a las
centésimas. Fichero PO3Prog05.tst.

Practica
Programa 1
Primero, crearemos un programa en blanco (File > New).

En TestPoint, antes de cualquier accién debemos definir los controles que vamos a utilizar. En

este programa vamos a necesitar un PushButton al que llamaremos Adquirir. Para afiadir
un nuevo PushButton debemos seleccionarlo desde la ventana Stock y soltarlo en la ventana
Panel (que es donde definimos la interfaz grafica de nuestro programa). Acto seguido, nos
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aparecerd una ventana donde nos preguntaran qué nombre deseamos darle a nuestro nuevo
control como la llustraciéon 35.

-
Sabiendo esto, anadiremos también un control GPIB . al que llamaremos K2700 y que sera
el encargado de la comunicacidn con el Keithley 2700. En el apartado GPIB Address,
escribiremos 16, que es la direccidon que estamos usando actualmente.

Obsérvese que cada vez que afiadimos un control, aparece en la lista de la ventana Objects.
También afiadiremos los siguientes controles:

® Un objeto Loop O al gue nombraremos Bucle y que sera el encargado de repetir el
proceso de la medicién.

A
® Un objeto Graph gue serd el encargado de dibujar la grafica y al que daremos el
nombre de Grafica.

. 1.2] . .
® Un objeto Data-Entry que renombraremos por Medidas y sera el encargado del
numero de lecturas que efectuara el bucle Loop.

® Un objeto Display E que denominaremos Temperatura y serd el encargado de
mostrar la temperatura medida en el termopar en cada instante.

I xd
(PR Pushbutton I Help_|

I:' Exec. actions at initialize

[ visible | | [<] Enabled | | BG Color | Ambient(panel) x|

Caption Font

S ettings | Actions | Comments | #Ref | Datal

llustracion 35: ventana Settings

Actualmente ya tenemos todos los objetos necesarios. Ahora aprenderemos a asignar las
Actions o eventos a los controles.

En el menu contextual del PushButton “Adquirir” seleccionaremos Action List. En el Action List
es donde escribiremos las instrucciones que se deben realizar cuando se haga clic en el botén.

Rafael Vargas Sanchez.
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Object "Adquirir” [App. #2] O] x|
[ owputo |

Enter from
Trigger
Clear

Serial poll

Parallel poll

Local

Remaote

Transmit GPIB commands

Settingz  Action: | Comments | #Ref | Datal

llustracion 36: funciones de GPIB

Para crear una nueva instruccién, arrastraremos el objeto GPIB desde la ventana Objects,
pinchando en el icono (no en la etiqueta de texto), hasta la Action List. Automaticamente, nos
aparecera un menu con las funciones disponibles del objeto GPIB. Seleccionaremos Output To
y, a continuacion, en la campo Width, escribiremos “*RST” para reiniciar el K2700.

Lo siguiente sera llamar a la funcién Clear Graph que seleccionaremos al arrastrar el objeto
Grafica en el Action List. Después, arrastraremos Bucle a la lista de acciones de Adquirir y
seleccionaremos Lineal Series. Asi se realizara incrementard de uno en uno el bucle hasta
alcanzar el limite. En el campo From escribiremos el valor 1y en el To arrastraremos el objeto
Medidas directamente desde la ventana Objects.

Hecho esto, ahora escribiremos las instrucciones interiores del bucle. Puede observar la
identacidn que se produce al escribir nuevas instrucciones. De nuevo, usaremos en el K2700
con la instruccién Output To. Utilizaremos los comandos necesarios para la lectura de la
temperatura de un termopar tipo T. Vea el anexo B para mas detalles de las instrucciones.

Tras esto, utilizaremos la funcién Enter From del objeto GPIB gracias a la cual podremos leer
los resultados de la medicion. Ahora debemos mostrar por pantalla el resultado de esa lectura
y para ello utilizaremos la opcién Set del Display Temperatura y en el campo To
especificaremos el K2700.

Finalmente, arrastramos el objeto Grafica al Action List y elegimos la opcién Add Point(s) To.
En el campo From arrastramos el objeto K2700.

El Action List resultante debe ser como este.

Rafael Vargas Sanchez.
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Object "Adquirir” [App. #3]

t____ 1) Outputto | K2700  with "SRSTY [ term=LF sendEOI?=0_ .
2] Clear graph Grafica
[ 3] Linear series Bucle from 1 to Medidas. step by 1
4]  Dutput to K2700 with "FUNC 'TEMP™ . . term_=LF send EOI?=1
5] Output to K2700 with "UNIT-TEMP C" . . term_=LF zend EOI?=1
6] Dutput to k2700 with "TEMP:TRAN TC™ . . term_=LF send EOI?=1
7]  Dutput to k2700 with "TEMP:-TC:TYPE T" . . term.=LF gzend EOI?=1
8] ODutput to K2700 with "ROUT-CLOS [@104]" . . term_=LF send EOI?=1
9] Output to k2700 with “"READ? | . term_=LF zend EOI?=1
10]  Enter from k2700 up to 256 bytes, stop on EOS=LF or EOI
11] Set Temperatura to K2700
121 Add point[s] to Grafica from Temperatura , . max. # points=50
L 13) End Bucle

Settingz  Actions I Comments | HRef | Datal

Antes de ejecutar nuestro primer programa, cambiaremos algunas propiedades del objeto

Temperatura, ya que mostraria todo el contenido de la lectura y lo que a nosotros realmente

nos interesa es el valor y dos cifras decimales. Para ello, hay que dirigirse a las Settings e

indicar lo siguiente:

e Type: Numeric
e } Digits: 2
¢ Number format: Fixed

Object "Temperatura™ [App. #4]
[Fr Y Temperatura | Help |

Initial Value [ |

Humber Format m
Text if no data |:|

BG Color | Black |

Text Color |Yellow j Text Size [dots]

=101 x|

E Yizible Caption BG |Amhient[panel] j|

E Bezel E Caption Caption Font

Settings | Achions | Commentz | =Ref | Datal

Este seria el aspecto de nuestro programa.
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Panell [App.#3 PO3Prog0l.tst]

Ahora s6lo nos queda hacer clic en el mend Mode=Edit, escribir un nimero de medidas mayor
qgue 0 en Medidas y pulsar el boton Adquirir.

Nota: para no tener que escribir continuamente un nimero de medidas, en modo edicién,
rellene el campo Initial Value con un valor en las Settings de Medidas.
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Programa 2
Partiendo del trabajo realizado en el programa 1. Ahora vamos a incorporar el objeto Timer

@ para medir el tiempo transcurrido entre cada medicion. En concreto, lo que haremos sera
medir el tiempo transcurrido desde el comienzo de la ejecucidn hasta el momento en el que se
realiza la medida.

Para ello, vamos a afiadir un objeto Timer al que llamaremos Temporizador. En la opcion Time
Format seleccionaremos “Secs. elapsed...”. Mediante este sistema después podremos realizar
una diferencia aritmética entre el Tiempo Inicial y el actual.

Object "Temporizador” [App. #4] o [m] S

Name |Tempurizadur | Help |

Time format | HH:MM: 55

Secs. elapsed [since Jan. 1 1970]
HH:MM

L[l
m—

1

: {HH:MM Mon. day year
Settingz | ActionE [ COmmemts | <Hef | & |

Evidentemente, tendremos que almacenar el instante inicial. Para ello utilizaremos el objeto

Container. Los containers son variables que permiten almacenar todo tipo de datos. Le
llamaremos Tiempolnicial.

Para calcular la diferencia de tiempo, tendremos que utilizar la resta. Con el objeto Math iy
calcularemos la resta. Crearemos uno con la siguiente formula: “x - y” y le llamaramos
DiferenciaTiempo.

También afiadiremos un nuevo objeto Display al que llamaremos TiempoTranscurrido donde
se mostrara la diferencia de tiempo.

Hecho esto, ahora sélo debemos modificar el Action List de Adquirir.

Arrastraremos el objeto Temporizador antes de entrar en el bucle y le asignaremos un Interval
de 0.1. Asi mismo, almacenaremos el instante inicial arrastrando Tiempolnicial con la funciéon
Store In utilizando Temporizador en el campo From.

Después del bucle, calcularemos la Diferencia de tiempo. Para ello, utilizaremos la funcion
Calculate del objeto DiferenciaTiempo y en los pardmetros x e y colocaremos Temporizador y
Tiempolnicial respectivamente. Acto seguido, mostraremos el valor por pantalla con la funcién
Set del objeto TiempoTranscurrido, donde el campo From tomara el valor del resultado de
DiferenciaTiempo.

Finalmente, pararemos el Temporizador con la funcién Stop.

Consejo: si quiere ver la ejecucion paso a paso utilice Single Step Mode en el menu Debug.
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_ijx
1] Output to K2700 with "*H5T" . , term_=LF send EOI?=1
2] Clear graph Grafica
3] Start Temponzador interval=0.1
4] Store in Tiempolnicial from Temporizador .
[ 5] Linear series Bucle from 1 to Medidas, step by 1
6] Output to K2700 with "FUMC "TEMP™ . . term.=LF send EOI?=1
7] Output to K2700 with "UNIT:-TEMP C* . . term.=LF send EOI?=1
_____ 8 Outputto  K2700  with "TEMP-TRANTC" .| tem-LF  sendEOI>=1
_____ 9 Outputte  K2700  with "TEMPTCTYPET" .| .tem-LF _ sendEOI?-1
10]  Output to K2700 with "BOUT:CLOS [@104])" . . term.=LF send EOI?=1
11]  Output to K2700 with "READ?" . . term.=LF send EOI?=1
12]  Enter from K2700 up to 256 bytes, stop on EOS=LF or EOI
13] Set Temperatura to K2700
14] Calculate DiferenciaTiempo  with X=Temponzador ¥'=Tiempolnicial
18] Set TiempoTrancumrido to Diferencial iempo
16] Add point{z] to Grafica from Temperatura . . max. # pointz=50
L 17) End Bucle
18] Stop Temponzador
Settingz  Actions I Comments | #FRef | Datal
llustracion 37: action list de Adquirir para el Programa 2
_ioix]
Grafica Inspect | Temperatura

K2700 GPIB address

Medidas

Adquirir

llustracion 38: controles alineados en el Panel
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Programa 3

En el programa 3 almacenaremos los resultados en una tabla (Grid E). Asi podremos
consultar todas las mediciones realizadas durante la ejecucién del programa.

Como ya hiciéramos antes, partiremos del programa anterior (Programa 2) y afiadiremos
varios controles mds asi como varias instrucciones en el Action List de Adquirir.

Afadiremos los siguientes objetos:

e Un objeto de tipo Grid al que denominaremos Tabla. En el campo Max. Cols
insertaremos el valor 2 (nimero de columnas maximo).

e Un Container al que llamaremos Muestra.

e Un objeto Math al que llamaremos Incremento y sera el encargado de incrementar en
una unidad la variable Muestra. En él escribiremos la siguiente formula: “x + 1”.

En el Action List de Adquirir escribiremos las siguientes sentencias:

Después de la accion Clear Graph, afiadiremos Clear Muestra para que siempre empiece a
contar desde 0.

También haremos un Clear del objeto Tabla.

Antes de acabar el bucle, utilizaremos la funcidn Calculate de Incremento con x = Muestra y
almacenaremos el resultado en Muestra con la funcidn Store In.

Finalmente arrastraremos el objeto Tabla después de la linea Add point(s) to y selecionaremos
Set Cell In. En campo row (fila) utilizaremos el valor de Muestra, en col el valor 0 y en value,
DiferenciaTiempo. Reiteramos el proceso nuevamente, salvo que esta vez podremos col =1y
value = Temperatura.

La lista de acciones de Adquirir deberia ser como la siguiente.
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_ioi x
_____ 1] Outputte  K2700 eith "5RSTT. . tem=LF  sendEOI?-1 =
2] Clear graph Grafica
3] Clear Muestra
4] Clear Tabla
B) Start Tempornizador interval=0_1
6] Store in Tiempaolnicial from Temponzador .
[ 7] Linear zeries Bucle from 1 to Medidaz. step by 1
8] Output to K2700 with "FUHC ‘'TEMP™ . . term.=LF zend EOI?=1
9]  Output to K2700 with "UNIT:-TEMF C* . . term_=LF send EOI?=1
10]  Output to K2700 with "TEMP-TRAN TC" . . term_=LF send EOI?=]1
111  Output to K2700 with "TEMP:TC:TYPE T . . term_=LF send EOI?=]1
12] Delay Timel for 0.05%  seconds
13] Output to KZ2700 with "ROUT:CLODS [@104])" . . term.=LF send EOI?=1
14]  Output to K2700 with "READ?" ., . term_=LF send EOI?=1
19] Enter from K.2700 up to 256 bytes, stop on EQS=LF or EON
16] Store in Temp from K2700 .
17] Calculate Redondeo with x=Temp
18] Set Temperatura to Redondeo
19] Calculate DiferenciaTiempo  with X=Temponzador ¥=Tiempolnicial
20] Set TiempoTrancumdo to Diferencial iempo
21)  Add point{s] to Grahca from Temperatura . . max. # points=10
22] Setcellin Tabla row=Muestra, col=0 . value=TiempoTrancurmdo
23] Setcellin Tabla row=Muestra, col=1 . walue=Temperatura
24) Calculate Incremento with x=Muesztra
25] Store in Muestra from Incremento .,
L 26) End Bucle
27) Stop Temporizador

Settings  Actions I Comments | HRef | Datal

Ahora, haremos una pequefia modificacidn a las Settings de la tabla. En la propiedad Col.

Labels vamos a separar con comas las etiquetas de las cabeceras.

Object "Tabla" [App. #16]

Name [IEE |

=101 x|

Help |

I:' Numeric

Data type | Amay

Col. widths |

Col. labels |T(s).T(C)

[<] Visible

[<] Enabled

|:| Grayed

BG Color |Amhient[Dﬂ"E“ j|

E Bezel

@ Caption

Caption Font

Settings | Arctions | Comments | =R ef | Drata |
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También estableceremos un color personalizado para el botdn Adquirir. Desde la pestaiia
Settings cambiaremos la propiedad BG Color a Lt Red y haciendo clic en Caption Font,
cambiaremos el color de la fuente a

Object "Adquirir” [App. #4]

Finalmente, nuestra interfaz deberia tener la siguiente apariencia.

Hame |Adquirir

| Help |

|:| Exec. actions at initialize

=101 x|

[<] ¥isible [<] Enabled

BG Color |Lt Red

=

Caption Font

Settingz | Actions | Comments | #Fef | [ ata |

= panell [App.#13 PO3Prog03.tst]

=] .5

Grafica

Inzpect |

Temperatura

TiempoTrancurrido

el | T | | P | = D

=

K2700 GPIB address

Medidas |
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Programa 4

En el programa 4 vamos a escribir en un fichero de texto plano el contenido de la tabla que
anteriormente hemos rellenado. Para llevar a cabo esta accidn, al programa anterior, vamos a
anadirle los siguientes objetos:

e Un PushButton al que llamaremos Guardar.

e Un objeto de tipo File E al que llamaremos Fichero.
e Un objeto Timer que llamaremos FechaActual. En sus propiedades elegir la opcién
HH:MM:SS dd/mm/yy en el apartado Time Format.

En el siguiente paso, lo que debemos es escribir las instrucciones de la lista de acciones de
Guardar. Para ello, arrastraremos el objeto Fichero y elegiremos la opcién Show Dialog. Acto
seguido, utilizaremos la funcién Erase de Fichero.

Finalmente escribiremos en Fichero el Timer FechaActual y Tabla tal y como se muestra en la

captura.
Object "Guardar” [App. £18] -0 x|
2] Eraze Fichero
3] Output to Fichero with Fecha actual . . term_.=CRLF
4] Output to Fichero with "T[=lAx09T[C]" . . term_=CHLF
5] Output to Fichero with Tabla . . term_.=CRLF

Settings  Actionz | Comments | #Ref | Datal

Después, modificaremos un poco la interfaz como ya hemos descrito anteriormente:

7 Panell [App.#14 PO3Prog04.tst] 101 =]

Grafica Inzpect | Temperatura
TiempoTrancurrido ‘

T(s) o | ﬂ
0
1
2
3
4
5
5
7
8
9

10

hd|

||K2?l]l] GPIB address

Medidas | |

Rafael Vargas Sanchez.
Alfredo Michan Amado.



Memoria de Ampliacién de Fisica| 2008

Ahora sélo queda ejecutar el programa, tomar un nimero de medidas con Adquirir y después
Guardar para ver el resultado.
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Programa 5

Finalmente, en el programa 5, haremos lo mismo que en el Programa 4 pero midiendo en
todos los dispositivos simultdneamente.

En la grafica afiadiremos tres dispositivos: PT100, NTCy TC.

Ademas por cuestiones de redondeo, afiadiremos varios containers a los que después
calcularemos la funcidén matematica siguiente:

Object "Redondeo” [App. #7] =1ox]
{5 Redonded | Help_|

Formula |slr[cunvertToNumher[x],“Z-l].2[“] | |

| Math Wizard. ..

Seltings IActions | Comments | xRef | Datal

Suponemos que hechos los anteriores programas, no debe entrafiar ninguna dificultad
entender la siguiente Action List de Adquirir.

i

E Panell

@ Tiempolnicial

Wiy DiferenciaTien

E TiempoTrancu
5| Muestra

&y Incremento

E Tabla

@ Timel
Guardar
E Fichero

(\3) Fecha actual

v Redondeo
Temp

&) TC

NTC

&) PT100
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Object "Adquirit" [App. #1]

_____ 1) Outputte  K2700 with ™AST" . . term=LF _ sendEOI?=0 4]
2] Clear graph Grafica
3) Clear Muestra
4] Start Temporizador interval=0.1
5] Store in Tiempolnicial from Temponzador .
[ B6] Linear sernes Bucle from 1 to Medidas, step by 1
7]  Output to K2700 with “FUNC ‘TEMP*™ . . term_=LF send EOI?=1
8]  Output to K2700 with “UNIT:TEMP C" , . term_=LF send EOI?=1
9] Output to KZ2700 with “TEMP:TRAN TC" . . term.=LF send EOI?=1
10)  Qutput to K2700 with “TEMP-TC-TYPE T" . , term.=LF send EOI?=1
11]  Delay Timel for 02 seconds
12]  Output to K2700 with "ROUT:CLOS [@104)" . . term.=LF zend EOI?=1
13] Output to K2700 with "READ?" , term.=LF send EDI?=1
14]  Enter from K2700 up to 256 bytes, stop on EOS5=LF or EOI
19] Store in TC from KZ2¥700 |
16] Calculate Redondeo with x=TC
17] Store In TC from Redondeo ,
18] Calculate DiferenciaTiempo  with X=Temponzador Y=Tiempolnicial
19) Set TiempoTrancurrido to DiferenciaT iempo
20]) Setcellin Tabla row=Muestra, col=0 , walue=TiempoT rancurrido
21]  Setcellin Tabla row=Muesztra. col=1 . walue=TC
22]  Output to K2700 with “FUNC ‘'TEMP™ , . term.=LF send EOI?=1
23]  Output to K2700 with “TEMP-TRAM FRTD" . term.=LF zend EOI?=1
24]  QOutput to K2700 with “TEMP:FRTD:TYPE PT100" , . term.=LF send EOI?=1
28] Delay Timel for 0.2 seconds
26]  Output to K2700 with "ROUT:CLOS [@105])" , . term.=LF send EOI?=1
27]  Output to K2700 with "READ? . . term.=LF send EDI?=1
28]  Enter from K2700 up to 256 bytes, stop on EOS=LF or EOI
29] Store in PT100 from K2700 .
30] Calculate Redondeo with x=PT100
31] Store in PT100 from Redondeo ,
32]) Setcellin Tabla row=Muestra. col=2 . walue=PT100
33]  Qutput to K2700 with “FUNC ‘'TEMP*™ , . term.=LF send EOI?=1
34])  QOutput to KZ2700 with “TEMP:TRAN THER" . . term.=LF zend EOI?=1 —
35)]  Output to K2700 with “TEMP-THER 1950" , . term.=LF zend EOI?=1
36] Delay Timel for 02 seconds
37]  Output to K2700 with "ROUT:CLOS [@103)" . . term.=LF zend EOI?=1
38) Output to K2700 with "READ? . . term.=LF send EDI?=1
39]  Enter from K2700 up to 256 bytes, stop on EOS5=LF or EOI
40] Store in NTC from KZ2¥700 |
41] Calculate Redondeo with x=HTC
42] Store in NTC from Redondeo ,
43] Setcellin Tabla row=Muestra, col=3 ., walue=HTC
44]  Output to K2700 with “FUNC ‘RES™ . , term.=LF send EDI?=1
45]  Delay Timel for 02 seconds
46)  Output to K2700 with "ROUT:CLOS [@102)" . . term.=LF zend EOI?=1
47]  Output to K2700 with "READ? , term.=LF send EDI?=1
48]  Enter from K2700 up to 256 bytes, stop on EOS5=LF or EOI
49]  Store in Temp from K2700 .
h0] Calculate Redondeo with x=Temp
51]  Store in Temp from Hedondeo
52) Set cell in Tabla row=Muestia, col=4 . value=Temp
53]  Output to K2700 with “FUNC ‘RES™ . . term.=LF gend EOI?=1
54] Delay Timel for 0.2 seconds
55)  Output to KZ2700 with "ROUT:CLOS [@101)" . . term.=LF gend EOI?=1
56)  Output to K2700 with “READ?" , term.=LF send EDI?=1
57]  Enter from K2700 up to 256 bytes, stop on EOS5=LF or EOI
58] Store in Temp from K2700 .
59] Calculate Redondeo with x=Temp
60]  Store in Temp from Hedondeo
()] Set cell in Tabla row=Muesztia, col=5H ., walue=Temp
62])  Add point{z] to Grafica from TC . PT100 . HTC . . max. # pointz=10000
53] Calculate Incremento with x=Muestra
64]  Store in Muestra from Incremento .
L 65) End Bucle
B66] Stop Temporizador z‘

Settingz  Actions | Comments | *Ref | Data |
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Finalmente, un ejemplo de este programa en ejecucién podria ser el siguiente:

¥ Panel1 [App.#1 PO3Prog05.1st]

Tis] [TC T(C) [PT100 T(C[NTC TIC) [PTC R{Oh[LDR R{Oh] |
5 71 59 21.76 20.84 2002 10010 43475 | 22.5
6 25.44 21.55 20.84 1990 100.03 43593
7 29.28 21.29 20.84 19.84 10010 43421 22.0
8 33.14 213 20.85 19.82 100.25 43525
9 36.99 21.77 20.85 2007 10095 43505 21.5
10 40.84 21.932 20.85 2000 10057 43511
1 44.74 21.67 20.85 1994 10030 435.07 21.0
12 4859 21.55 20.85 19.89 10014  433.48
13 52 44 21.45 20.85 19.89 10010 43457 20.5
14 56.28)  21.44 20.86 19.85  100.08 43365
15 60.14 21.38 20.86 19.80 100.08  436.15 20.0
16 63.99 21.40 20.86 19.77  100.05 436.05
17 67.84 21.30 20.86 19.69 9993 43582 19.5
18 71.74 2112 20.86 19.61 9984 43558
19 75.59 20.98 20.86 19.56 99.78 43661 .

TiempoTrancurrido

K2700 GPIB address
75.59 ot L =T

Y con esto concluimos la practica de TestPoint.
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Practica 4: NI LabView 6i
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Introduccion

En esta practica desarrollaremos cuatro programas utilizando el entorno LabView para realizar
medidas y almacenar los datos extraidos del K2700 en un fichero externo.

LabView es un entorno de desarrollo de programas parecido a otros entornos de
programacion estructurada. Sin embargo LabView utiliza un lenguaje de programacién grafico
para crear programas en forma bloques de diagramas.

Ademas, LabView incluye las herramientas comunes de un entorno de desarrollo: breakpoints,
traza de ejecuciones, etc. Haciendo mas facil desarrollar los programas.

Rafael Vargas Sanchez.
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Objetivos

Durante el transcurso de esta practica disefiaremos cuatro programas:

e Un programa que envie una sola instruccion al K2700. En el ejemplo concreto
enviaremos la funcion Reset (*RST). Fichero PO4Prog01.vi.
e Un programa para leer la medicion de la LDR utilizando estructuras secuenciales

(.EEE Sequence). Fichero PO4Prog02.vi.

e Un programa que escriba la lectura anterior en un fichero de texto plano. Fichero
P04Prog03.vi.

e Un programa que escriba varias medidas simultaneas de todos los dispositivos (LDR,
PTC, NTC, PT100, TC) en un fichero de texto con formato de tabla. Adicionalmente, esa
tabla también se muestra en el programa. Fichero PO4Prog04.vi.

Rafael Vargas Sanchez.
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Practica

Programa 1. Reseteo del K2700.
El objetivo de este programa es resetear la unidad de adquisicidon de datos K2700. Para ello le

enviaremos un comando *RST. Con este fin utilizaremos la funcién GPIB Write [EZI2H en la
ventana de Diagrama (la del fondo blanco). GPIB Write se encuentra en el menu Functions >
1/0 Intruments > GPIB > GPIB Write (llustracidn 39) y nos permite escribir directamente
comandos a la unidad. El menu Functions se abre al hacer clic con el botén derecho del ratén
sobre el fondo de la ventana.

«—Functions
’

o
! —HGPIB
GPIB Write
R
e
= ] T
G o

llustracién 39

En la ventana de Panel (la del fondo gris) crearemos dos String Control qgue llamaremos
Comando y Direccidn. Sino esta visible la ventana de Panel, haga clic en el menu

Windows > Show Panel. Cada vez que creemos un control en el Panel, un icono representativo
aparecerad en la ventana de Diagrama. Para mover libremente los controles por el Panel, utilice

la herramienta M Position/Size/Select en |a paleta de herramientas.

Antes de proseguir, hay que sefialar las diferencias entre String Control y String Indicator.
Ambos objetos nos serdn muy utiles a lo largo del desarrollo de la practica, pero hay que saber
que los controles marcados como Control son de sélo-escritura y los marcados como Indicator
son de sélo-lectura.

Rafael Vargas Sanchez.
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Otra detalle que conviene recordar es que los iconos que aparecen en el Diagrama tienen un
significado. El color ademas indica el tipo de datos (el color magenta indica un tipo String).

Teniendo en cuenta estas consideraciones basicas, podemos proseguir

EEEaul con el objetivo de esta practica. Si hemos realizado los pasos anteriores
Il5 correctamente, en la ventana de Panel deberiamos tener una interfaz
Comando semejante a la indicada en la llustracidn 40, sin los valores 16 ni *RST.
|*RST

Para introducir los valores respectivos a cada String Control, vamos a

llustracién 40: vista utilizar la herramienta ﬂ Edit Text. Al hacer clic en el espacio designado
de Diagrama. para escribir con esta herramienta podremos introducir texto. En campo

Direccidn, indique en qué puerto GPIB se encuentra el K2700 (en nuestro
caso el 16). En el campo Comando escriba el comando *RST que reiniciard la unidad a su

estado inicial.

Mientras tanto, en la ventana de Diagrama, deberiamos tener algo similar a lo que se muestra
en la ilustracion 3. Si no se muestra la ventana de Diagrama, haga clic en el mend Window >
Show Diagram. Los “hilos” que actualmente unen todos los objetos son el fundamento de
LabView. El color de estos hilos muestra el tipo de datos que se estd uniendo y el grosor la
“cantidad” (un valor simple, un array, una matriz, etc.).

Para nuestro programa uniremos la entrada Data del objeto GPIB al objeto Comando y la
entrada Address String al objeto Direccion. Tal y como se indica en la llustracién 41.

Bireccion

&

.13

llustracion 41

Tﬁ Para tal efecto, seleccionaremos la herramienta @ Connect Wire desde la
k[A paleta (llustracién 42) y cliceando respectivamente donde hemos indicado
> [r= anteriormente tendremos configurada la escritura en el K2700.

B

@ e «55’ Una alternativa a este programa podria ser poner los datos de entrada como
% / constantes si sabemos que alguno de los datos no cambiara. Asi pues,
utilizaremos un objeto String Constant del menu String, en sustitucion

llustracién 42 del objeto String Control .

Si hemos seguido todos los pasos como se ha indicado, podremos hacer clic en el comando

Run en la barra de herramientas y se ejecutara nuestro programa. Si por algin motivo se
nos hubiese olvidado conectar alglin elemento esencial de la configuracion, el icono de Run

apareceria como en la siguiente imagen: @

4 Rafael Vargas Sanchez.
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Programa 2. Lectura del K2700.

En este programa leeremos una medida de la LDR y lo mostraremos por pantalla. Ademas
ilustraremos el uso de la secuencia. Lo primero que haremos serd insertar una secuencia en el
diagrama desde el menu Functions > Structures > Sequence.

+Functions

M= *| T3 *|
T —
«—HStructures

HE)

_I
]
E>E_} . o s
E v [
|

nn

Después, pinche y arrastre hasta crear un objeto de un tamafio aceptable. Asegurese de que la
secuencia tiene al menos tres marcos. Vera el nimero de marcos en la parte superior central

de la secuencia. ::

Si necesita afiadir mas marcos o eliminar los existentes, en el menu contextual encontrara Add
Frame After, Add Frame Before y Delete This Frame que afiadirdn un marco antes del actual,
después del actual o eliminara el marco seleccionado respectivamente.

En el primer marco de la secuencia (el nimero 0), creamos un objeto String Constant con

el valor *RST y un objeto GPIB Write(E=1'2H,

Crearemos un objeto String Control en el Panel y lo llamaremos Direccion. Conectaremos éste
como hiciéramos en el apartado anterior y deberiamos tener un diagrama similar al mostrado
en la llustracion 43.

1000000 o00onmn U[DE]DDDDDDDDDD

N O0000O0O0O0O000O0O00O00

Direccian

100 Noood

llustracion 43
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Como se puede observar, al conectar un elemento de fuera con otro de dentro del marco, un
pequefio rectdngulo se muestra en el borde.

En la segunda celda creamos otro objeto GPIB Write y un objeto String Control, al que
llamaremos Comando. Este Ultimo objeto debe ser creado en el Panel. Si el icono del objeto
aparece fuera del marco en el diagrama, muévalo hacia dentro. Para cambiar el marco

mostrado por la secuencia, haga clic en el botén E| de la parte central superior.

Al igual que hicimos antes, conectaremos la entrada Data del objeto GPIB Write con Comando
y la entrada Address String con Direccidn. El resultado se asemejara a lo mostrado en la
Ilustracion 44.

10000000000 l[UE]DDDDDDDDDD

2. [E]
E20i4)

llustraciéon 44
En este marco se enviara el comando guardado en el control Comando al K2700.

o (3]
-

En el ultimo marco (ndimero 2) creamos un objeto GPIB Read E=ICH (Functions > 1/0
Intruments > GPIB > GPIB Write), un Boolean False Constant (Functions > Boolean >

False Constant), un Fract/Exp String To Number [2-*#| (Functions > String > String/Number
Conversion > Fract/Exp String To Number) y un Numeric Constant (llustracién 45) de valor 50
que sera el tamafio del buffer de lectura.
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+HFunctions
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llustracion 45

En el panel crearemos un Error Out Cluster llamado Error (Controls > Array & Cluster >
Error Out 3D), un objeto String Indicator llamado Buffer (Controls > String & Path > String
Indicator), un objeto Digital Indicator (Controls > Numeric > Digital Indicator) llamado Ohms.

Al objeto GPIB Read le conectamos en la entrada Address String el objeto Direccién. En la
entrada Byte Count la constante numérica 50 (para indicarle que se leeran como maximo 50
bytes). En la salida Error Out del GPIB Read le conectaremos el objeto Error (para que nos
indique los errores que se han producido en el K2700, si es que se ha producido alguno) y en la
salida Data conectamos el objeto Buffer (que mostrara todo el contenido del buffer de salida
del K2700).

En el objeto Fract/Exp String To Number [2-+*#| conectamos en la entrada String al objeto
Buffer (para convertir el dato a un tipo numérica), en la entrada Use System Decimal Point la
como separador

“un o n

constante False (para que utilice el caracter “.” en lugar de la coma
decimal) y en la salida Offset Past Number el obJeto Ohms (para que muestre el valor

numérico en un formato entendible por nosotros).

Nos deberia resultar un diagrama como el presentado en la llustracién 46.
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1000000000 E[UE]DDDDDDDDDD

llustracion 46

Ahora solo falta dale el valor 16 a Direccidn y rellenar las sentencias necesarias en comando.
En este caso, las necesarias para leer los Q de una LDR.

FUNC 'RES'

ROUT:CLOS (@101)

READ?

Para que los valores introducidos se almacenen permanentemente en el programa, debemos
seleccionar la opcion Make Current Values Default del menu Operate.

Pulsamos Run y debemos obtener unos resultados similares los presentados en la

llustracién 47.

Errar Direccicn Ohms
status  code 16 404,54
il HU Comando Buffer
source FUMC 'RES' +4.04535248E+020H
_~| JROUT:CLOS (@101) M,+905.4965EC5,
READ? +00396RDOMNGF
_-|

llustracion 47

En caso de que se produjese un error en la lectura, el Error Out Cluster nos indicaria la el

codigo del error.
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Programa 3. Escritura a disco.
El programa 3 es una variante del programa 2. En los marcos 0 y 1 no se realizara ninguna
modificacion.

En el marco 2 afiadiremos los siguientes controles: un objeto Open/Create/Replace File =1%n],

FILE
un Write File W{ un Close File ] (menu Functions > File I/0); un Numeric Constant con

#F
et
valor 2, un Number To Fractional String =] (Functions > String > String/Number
Conversion).
o—1HFunctions
¥ T
==
abc k *
[E]1]2]
=
E}‘ ME » Elr
i hee «~1=File /O
%-*EEIJ.EJ; DpenfCreate/Replace Hle.vi
to &t [l fbe.)| [fabca E‘
% *.%*z ' B B = 2 %
[=IH .r"ﬂ]]h ru_: FILE O % 0 H
28 e odlsis .L&J@
AT .P v _
== D8 |

llustracién 48: Mend File 1/0

En el Panel afadiremos un File Path Control al que llamaremos Fichero (Controls >
String & Path > File Path Control) y un Cluster Error Out al que llamaremos Error de
Fichero.

Fichero

an c\prueba.bd E'

llustracion 49:Ejemplo del File Path Control

Conectamos la entrada File Path de Fichero al Open/Create/Replace File y la constante
numeérica 2 a la entrada Function de éste. El modo 2 muestra un cuadro de didlogo en el que
podremos seleccionar la ubicacidn del archivo y qué nombre quedemos darle. Si ademas el
fichero ya existe, nos permitira indicar si queremos reemplazar los contenidos del archivo
existente.

En el objeto Number To Fractional String conectamos en la entrada Number al objeto Ohms
que es el que almacena el valor de la medida. Este objeto convertira el tipo numérico a tipo
cadena para poder ser escrita en el archivo.
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Ahora vamos a proceder a conectar la salida de errores de fichero. Los errores de fichero se
pueden producir en cada una de las etapas (Abrir, Escribir, Cerrar). Por ello, debemos
conectarlas en cascada para que se pueda propagar, es decir, la salida Error Out de
Open/Create/Replace File se conectara a la entrada Error In de Write File. La salida Error Out
de Write File se conectara a la entrada Error In de Close File. Por ultimo, la salida Error Out de
Close File se conectara al Error Out Cluster Fichero. Si se produjese un error durante alguna de
esas fases, seria este control quien nos indicaria de ese error.

Al igual que hiciéramos con el Error, debemos propagar por cada uno de los objetos que
trabajan con el fichero el refnum. El nimero de referencia de un fichero abierto es un valor
univoco que identifica a cada fichero abierto. Asi la salida dup refnum de
Open/Create/Replace File deberd ser conectada con la entrada del refnum del siguiente
objeto. Ver llustracién 50 para tener una idea grafica.

Lo Unico que nos queda por conectar es la salida F-format string a la entrada Data de Write
File.

Si hemos seguido todos los pasos correctamente, las conexiones deberian quedar como se ve
en la llustraciéon 50.

10000000000 E[UE]EIDDDDDDDDDDD

Fichero

g_ I{W;l Error de Fichero

llustracién 50: Conexiones de fichero

Si todo ha transcurrido correctamente al ejecutar, en el Panel, deberiamos tener algo parecido
a lo mostrado en la llustracién 51.
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ROUT:CLOS (@101)
READ?

cprucbasct | 8

llustracién 51: Ejecucion satisfactoria del Programa 3
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Programa 4. Medicion simultanea temporizada con volcado a fichero.
Finalmente, en el programa cuatro, mediremos simultdaneamente todos los dispositivos (e
indicaremos el tiempo de cada medida). También haremos uso de los Arrays de datos y de
Controles de LabView, asi como uso del control Tabla (Table).

Creacion de un Array de controles

Array Para crear un Array de controles lo primero que debemos hacer es

crear un objeto Array en el Panel (Controls > Array & Cluster >

|
=]

Array). En el diagrama deberia salirnos algo como esto yenel
Panel tendremos algo similar a la llustracién 52.

Ahora debemos indicar de qué tipo sera el Array. Dentro del
llustracion 52: apariencia del  racyadro mas oscuro bajo la etiqueta, crearemos un elemento del
Array en el Panel . ] . ]

tipo que necesitemos. En nuestro caso, utilizaremos un String

Control. Ademas, renombraremos el control a Comandos.

Cambie el tamafo del String Control con la herramienta

Comandos

[
EUNC "TEMP" Select J . Si se situa el puntero sobre alguna de las
TEMP:TRAN TC esquinas del control, apareceran las esquinas marcadas.

|
o

TEMPTCTYPET Pinche y arrastrar hasta obtener un tamafio adecuado.
TEMP:TC:RJUM:RSEL INT

ROUT:CLOS (@104) = =

READ? ||

Para cambiar de un elemento a otro del Array,

llustracion 53: elemento del Array utilizaremos la herramienta Operate Value ﬂ que nos

permitirda movernos por el Array. Ahora escribiremos
cada elemento del Array con los comandos necesarios para realizar una medida de cada tipo.
Los comandos se encuentran en el [Anexo B]. Debe quedar como algo parecido al Array de la
llustracion 53.

Bucle For Loop

Antes de nada, indicaremos lo siguiente: vamos a trabajar con una secuencia igual que la del
Programa 2. Lectura del K2700. Por ello, aqui obviaremos como se construye. Lo Unico que
indicaremos es que el control Ohms, pasa a llamarse Lectura y se encontrard fuera de la
secuencia. Asi como que el String Control Comando desaparece para dar paso al Array de
String Control Comandos.

Ahora, insertaremos un For Loop (Functions > Structures > For Loop). Crearemos una Numeric
Constant a la que le daremos el valor 5 (pues medimos 5 sensores) y la conectaremos con la N

E del For Loop. N es el limite superior y nunca se alcanza. Las iteraciones van de 0 a N-1.

Llega el momento de conectar el array Comandos con la estructura. Dato que los tipos de dato
no coinciden, utilizaremos una funcién que accede a uno y sélo uno de los elementos de un

4
i

array: Index Array (Functions > Array > Index Array). o | Esta funcion accede a un elemento
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de un array. Tiene dos entradas: Index e Input Array. Conectaremos la 1[G del For Loop a
Index y el Array Comandos a Input Array. La salida sera lo que conectemos a la entrada Data
del GPIB Write del marco 1 obteniendo un resultado como el de la llustracién 54.

Iﬁm
'I:|I:|I:|E|E|1!1[U”2]EFDDQEE P

|

i

=ty
[E]14)

Comandos,

[ab<]

llustracién 54: acceso al Array de comandos

Nota: obsérvese que Lectura permanece fuera de la secuencia.

Array de medidas

Si sacamos un cable desde lectura hacia fuera del For Loop, observaremos una pequeiia marca
en el borde. [ Esto quiere decir que automaticamente la lectura que se hace es a un array de
medidas con 5 elementos, por lo que nosotros no necesitamos crear el array resultante.

Por otra parte, dado que vamos a rellenar una Tabla en este programa, necesitaremos crear
una copia del valor como Texto. Lo cual ya sabemos realizar seglin vimos en el programa
anterior.

100o00an 2[02] oo [

Buffer

ooooon

Comandos
@ loo] [a.bc]
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Creacion de la tabla de medidas (array 2D)
Antes de proseguir, debemos especificar el niumero de mediciones que

se realizard a los sensores. Para ello vamos a afiadir un Digital Control
(Controls > Numeric > Digital Control) al que llamaremos N2 Medidas.

EXT || DBL || SGL Por defecto, el tipo numérico sera (Decimal), sin embargo,

nosotros necesitamos que sea un entero. En el menu contextual del

control, en la opcién Representation encontraremos todos los tipos

numéricos disponibles. En nuestro caso, dado que el nimero de

iz uis s
T

s of [ s ol | 7o medidas serd un numero mayor que 0y natural, seleccionaremos

b5 [GSE alguno de los tipos U. En concreto U16, ya que el rango de U8 esde 0 a
= 255 y nos gustaria disponer de mayor rango (de 0 a 65535). Nuestro

llustracién 55: control deberia tener |a siguiente apariencia.

representation

MN® Medidas

Hecho esto, ahora crearemos un nuevo For Loop. Conectaremos N2 Medidas con N. Pasemos

a ver cémo calcular el tiempo transcurrido.

Calculo de tiempo transcurrido
En este apartado vamos a calcular el tiempo transcurrido entre cada medida y el tiempo inicial.

Para ello vamos a utilizar el objeto Get Date/Time In Seconds =8 (Functions > Time &
Dialog > Get Date/Time In Seconds) que devuelve los segundos transcurridos desde el Viernes,

1 de Enero de 1904 a las 0.00 UTC.

Con dos de estos objetos colocados oportunamente y aplicando una resta I> podemos
obtener el nimero de segundos transcurridos entre dos lecturas como se muestra en la
Ilustracion 56.

Rafael Vargas Sanchez.
Alfredo Michan Amado.



Memoria de Ampliacién de Fisica | 2008

M# Medidas

EhZZE

100000 1[02] oo [u

o
[E2]12)

Comandos|

[-1 b 1:]

Direccian

abc

llustracion 56: medida de tiempo

Modificacion del Array de medidas

Dado que por cuestiones estéticas y por facilitar la lectura vamos a poner el tiempo
transcurrido en la primera columna de la tabla, debemos modificar el array obtenido en el
primer For Loop (el encargado de las medidas). Vamos a explicar como se consigue.

i
Lo Unico que debemos utilizar es un objeto Insert To Array g (Functions > Array > Insert To
Array). Conectaremos el Array saliente del bucle For Loop interno a la entrada Input Array y
una constante numérica de valor 0 a la entrada Index. Recordemos que los Arrays en LabView
comienzan en 0. Después de esto, conectaremos el resultado del Subtract (la resta anterior de
los tiempos) a la entrada New Element/Subarray

De la misma manera procederemos con la copia de tipo texto pero convirtiendo previamente
el tipo a String.

Representacion en una tabla

Aunque LabView ya trae un control Tabla por defecto, tendremos que modificarlo para que se
ajuste a nuestras necesidades. Lo primero sera hacer visible las cabeceras de columna (Menu
Contextual > Visible Items > Column Headers). Acto seguido, convertiremos el Control Tabla a
Indicador (Ment Contextual > Change To Indicator). Finalmente escribiremos en las cabeceras
de columna lo que representan tal como indica la llustracién 57.
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Tabla

T PT100 |LDR PTC MNTC TC il
10,00 2377 52629 10581 2279  |2385 J

10.64 2379 226,71 (10721 (2280 2412
21,08 2379 22763 (10595 (2271 23,81
51.64 23,81 22728 (10532 (2252 43,56
42,08 23,81 22747 (10525 (2241 43,33
52,53 23,81 22733 (10500 (2230 2312 |

llustracidn 57: cabeceras de columna

Ahora sélo nos queda unir la salida de bucle For Loop externo. Obsérvese que el grosor de los
hilos conectores crece a medida que salimos del Array.

| [m] |

Tabla
g 1 R e @mﬁiw [1b]

[m]

Formateo de Array 2D en texto
Finalmente, solo nos resta escribir el fichero con los datos obtenidos. Para poder formatear el
contenido de un array de dos dimensiones como una tabla de texto debemos utilizar el objeto

Array To Spreadsheet @ gue esta disponible en el menu Array.

En la entrada delimiter estableceremos cdmo que cardacter (o conjunto de estos) s e utilizara
como delimitante. Nosotros hemos utilizado el tabulador gue podemos encontrar en las
constantes String. En la entrada Format String conectamos una String Constant con el
siguiente contenido: “% . 2f”. En LabView se utiliza el mismo tipo de formato que en C. Por
tanto, hemos seleccionado redondear los decimales a centésimas. Finalmente, en la entrada
Array enlazaremos el Array que sale del For Loop exterior.

Por ultimo, sélo nos queda escribir en fichero la salida de Array To Spreadsheet. Pero antes
vamos a afadir un encabezado. Crearemos una String Constant, haremos clic derecho en el
mismo y seleccionaremos la opciéon \ Codes Display y luego escribiremos
“T\tPT100\tLDR\tPTC\tNTC\tTC\r\n” que después escribiremos al comienzo del
fichero. A continuacidn

Ahora sélo nos queda enlazar los objetos necesarios para la escritura de fichero como
hiciéramos en el programa anterior.

Si hemos seguido todos los pasos, nuestro Diagrama y nuestro Panel después de una ejecucion
deberian ser como los siguientes.
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M* Medidas
M
N ]
g
g HE

Tabla
[ak<]

TP T100\LDRVPTCHNT CiTC\rn|

“TEMP

TEMP:TCTYPET
TEMP:TC:RIUM:RSEL INT
ROUT:CLOS (@104)
READ?
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Conclusiones

En este apartado realizaremos una lista de Pros y Contras sobre los programas con los que
hemos realizado estas practicas y la conclusién a la que llegamos una vez analizadas estas
listas.

Xlinx

Pros
e Configuracion rapida del programa.
e No se necesita programar para tomar medidas.
e Realiza graficas automaticamente.
e Permite guardar los datos en hojas de célculo.

Contras
e Posibilidades limitadas tales como realizar tablas, guardar el tiempo de las medidas o
cambiar el formato de los ficheros.
e Requiere atencion constante del usuario.

Conclusion
Es el mejor programa para realizar unas cuantas medidas rapidas y para probar que los
dispositivos estén conectados correctamente.

HP VEE

Pros
e Facilidad de escritura en archivo (Transformacidn simple de tipos de datos e
introduccion de tabuladores y saltos de linea configurable)

Contras
e Poca usabilidad.
e Aspecto grafico paupérrimo.

Conclusion
No ha estado a la altura de las expectativas.
TestPoint

Pros
e Facil de programar por su parecido a los lenguajes de programacion tradicionales.

Rafael Vargas Sanchez.
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e Gran cantidad de opciones graficas que ayudan a realizar programas mds agradables a
la vista.

Contras
e Dificultad de escritura en los campos de la lista de acciones.
e Carece de redondeo real en los objetos (necesidad de redondear con formulas).

Conclusion
TestPoint es el programa mas sencillo para crear programas completos.

LabView

Pros
e Opciones casi ilimitadas (capaz de realizar todo tipo de graficas, operaciones...).

e Muy utilizado, lo que aumenta el nimero de guias y documentacién disponible en
internet.

Contras
e Manejo poco intuitivos (cables que salen de bucle For Loop se convierten en Arrays).

e Exceso de operadores (son demasiado concretos, por lo que hay que buscar el que
encaje exactamente para cada operacion).

Conclusion
LabView tiene mas potencial que el resto de programas, pero el uso es menos intuitivo.
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Anexo A: Montaje de la tarjeta de

A/D (Modelo 7700).

LOCK
8&
’/J]/ &
7}

5

llustracion 58: montaje y desmontaje del tornillo de la tarjeta de
adquisicion de datos.

Lo primero para montar la tarjeta de
adquisicion de datos sera abrirla
como indica el dibujo (llustracién 58:
montaje y desmontaje del tornillo de
la tarjeta de adquisicién de datos.).
Gire el tornillo hasta que pueda
levantar la tapa superior.

Al desmontar la tarjeta encontrara
una serie de conectores en los que
debera enganchar las distintas

conexiones de los sensores que se

utilizardn para la toma de mediciones
(Hlustracién 59).

Introduzca los cables por los huecos designados a tal efecto. Se encuentran dos huecos: uno
para los conectores de la parte superior y otro para los conectores de la parte inferior. Para el
caso de la tarjeta que nosotros utilizaremos a lo largo de las cuatro practicas (El modelo 7700),
tendremos 20 canales que podremos utilizar de la siguiente manera: como 20 canales de 2

terminales o bien como 10 canales de 4 terminales.
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INPUT SENSE CH1 CH2 CH3

N \\\\

CH4 CHS CH6 CH7 CH8 CH9 CHI10
HL HL HL HL HL

Wiy

Cable
W Tie Holes

////////

HL OHILH.L
CH22 3 ~— CHI1 CHI2 CH13

S

CH9 CH10
H L H L

llustracion 60: detalle de los terminales
de cada canal.

\
H L HL HIL H L HL HL HIL
CH14 CH15 CH16  CH17 CH18 CHI19 CH20

llustracién 59

En la llustracién 60 podemos ver al detalle cobmo son
los terminales. Cuando conectemos un sensor
debemos tener precaucién con la polaridad (ya que
estamos trabajando con sensores semiconductores
en la mayoria de los casos). De equivocarnos,
podremos obtener medidas erréneas o incluso dafiar
el dispositivo sensor.

Dicho esto, conectaremos nuestros sensores segun la
siguiente Tabla 1:

Canal Color Descripcidn

Cho1 (@101) [' Zzgro LDR

Ch02 (@102) [' ZZJ';O PTC

Ch03 (@103) [' Ezjgoro NTC

Cho4 (@104) [‘ m:;rct;n TC (Tipo )

chos (@105) [' Ezjgoro PT100

Ch15 (@115) [‘ Z(;jgoro .I.DTIOO (Fuente de Intensidad).

Tabla 1: conexiones
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Salvo la PT100, los demds dispositivos son de dos
terminales y no deberia existir ninguna
complicacidn para conectarlos al médulo de
adquisicion de datos. Para el caso de la PT100,
conectaremos como se indica en la llustracién
61.

Si por ejemplo, medimos la PT100 en canal Ch05,
los terminales de intensidad deberian conectarse
con un offset de +10, es decir, en el Ch15. El
offset depende del nimero de canales, para el

caso del modelo 7700 es 10.

Consideraciones

El termopar ha sido conectado directamente al
maodulo de adquisicién de datos ya que el
modelo 7700 posee un termdémetro interno.

Las mediciones del valor de la PTC son en Q (Ohm). Dado que el Keithley 2700 no viene
preparado para leer temperatura de este sensor.

Q4-Wire and RTD connections

HI 0—{:
' Resistor or
Channel 1 4-Wire RTD
1O o—

i (Channels 2-9) E

HI ©

Channel 10
LO o

7]

Resistor or
4-Wire RTD

HI O—o—
Channel 11

LOO—;—

! (Channels 12-19) E i

Channel 20

llustracion 61: conexion para elementos de cuatro

terminales.

La tarjeta de adquisicidn de datos esta insertada en el Slot 1.
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Anexo B: Comandos del K2700

A lo largo de toda esta practica, se han utilizado una serie de comandos del K2700 repetidos
continuamente (ya que los comandos del K2700 son independientes del entorno usado). En
cada entorno seran introducidos como sea necesario y utilizando las secuencias de escape
necesarias si procede. Los canales se han dejado tal y como estd montada la tarjeta de
adquisicion de datos.

Resetear la configuracion
*RST

Lectura de LDR (o PTC) en Q
FUNC 'RES'

ROUT:CLOS (@101)

READ?

Lectura de NTC en°C!
FUNC 'TEMP'
TEMP:TRAN THER
TEMP:THER 1950
ROUT:CLOS (@103)
READ?

Lectura de PT100 en°C
FUNC 'TEMP'

TEMP:TRAN FRTD

TEMP: FRTD:TYPE PT100
ROUT:CLOS (@105)

READ?

Lectura de TCen°C
FUNC 'TEMP'

TEMP:TRAN TC
TEMP:TC:TYPE T
TEMP:TC:RJUN:RSEL INT
ROUT:CLOS (@104)
READ?

! Aunque no se especifica, el K2700 devuelve la temperatura en grados a no ser que se le indique
explicitamente Fahrenheit o Kelvin.
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Contenido del CD

=701 —Xlinx
~/ Medidas
_] Tabla 50 muestras temperatura.xls Volcado de XLinx
~/ Programas
] K2700.inx Configuracion canales
-/ 02-HPVEE
-7 Medidas
_] Tabla Medidas 30 min.txt
~/  Programas

Resultados del Programa 5

PO2Prog01.vee
PO2Prog02.vee
PO2Prog03.vee
PO2Prog04.vee
PO2Prog05.vee
] PO2Prog05Alt.vee

EEEE D

/03 —TestPoint

Programa 1
Programa 2
Programa 3
Programa 4
Programa 5

Versién alternativa (guarda fila a fila)

~/ Medidas
_] Tabla 14 medidas.txt Resultados del Programa 5
] Tabla Resultado PO3Prog04.txt
~/ Programas
] PO3Prog01.tst Programa 1
] PO3Prog02.tst Programa 2
_] PO3Prog03.tst Programa 3
] PO3Prog04.tst Programa 4
_] PO3Prog05.tst Programa 5
~/ 04— LabView
-/ Medidas
] Tabla 10 medidas.txt Resultados del Programa 4
~/ Programas
_] PO4Prog01.vi Programa 1
] PO4Prog02.vi Programa 2
] PO4Prog03.vi Programa 3
] PO4Prog04.vi Programa 4
] Tabla.ctl Modificacidn control Tabla
-/ 10— Recursos Lea el archivo readme.txt para detalles del contenido de esta carpeta
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